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ABSTRACT 

Glioblastoma multiforme (GBM) is the most common malignant type of cancer of the Central 

Nervous System (CNS) and is characterized as highly angiogenic. Poor prognosis combined with 

short lifespan after diagnosis (⁓18 months) and resistance to the most invasive treatments highlight 

the need to understand the disease pathology at the molecular level. Angiogenesis plays an 

important role on tumor cell survival and malignancy, but the precise mechanisms that control the 

interactions between glial cells and blood vessels remain unknown. Drosophila melanogaster has 

emerged as an excellent model for GBM studies because glia-specific overexpression of 

EGFR/Ras and PI3K-Akt, the major pathways upregulated in human GBMs, causes low- and high-

grade gliomas. Our goal is to use Drosophila larvae to understand the mechanisms governing GBM 

tracheogenesis, the functional and molecular equivalent of angiogenesis.    

In this study we used immunofluorescence and confocal microscopy to characterize glia-tracheae 

interactions in established Drosophila GBM models. Specifically, we used the Gal4 – UAS system 

to overexpress the RasV12 oncogene, the constitutively active catalytic subunit of PI3K, Dp110CAAX, 

alone or in combination, in glial cells of Drosophila larvae. We found that the mitotic index in 

Dp110CAAX overexpressing brains was moderately increased, whereas brains overexpressing RasV12 

alone or in combination with Dp110CAAX exhibited strikingly increased mitosis compared to control 

brains. The levels of brain mitosis correlated with increased central brain size. In addition, brains 

overexpressing RasV12 alone had significantly increased number of apoptotic cells compared to 

controls, Dp110CAAX, and Dp110CAAX; RasV12 brains. To understand glia-trachea interactions, we 

needed to develop a model to visualize the trachea in GBM-bearing larvae. Since we were using 

the Gal4 – UAS system to overexpress the tumor-causing genes, we needed a different method to 

highlight the brain tracheal cells. We tested available trachea-specific QF-QUAS and LexA-

LexAop drivers, but they did not allow brain trachea visualization. Therefore, we reverted to using 

the QF -QUAS system to overexpress RasV12 in glial cells and the Gal4-UAS system to visualize 

the trachea, a combination that proved successful. The mitotic activity of this model agreed with 

our results from the brains overexpressing oncogenes using the Gal4-UAS system. Finally, our 3D 

imaging suggests increased tracheogenesis in brains overexpressing RasV12.       
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1. INTRODUCTION 

 

1.1 Glioblastoma multiforme  

 

Glioblastoma multiforme (GBM) is the most common primary type of cancer found in the Central 

Nervous System (CNS). It displays resistance to common treatments such as chemotherapy and 

radiotherapy due to the formation of tumor microtubes (Furnari et al. 2007, Read 2011, Portela-

Esteban, Casas-Tintó 2021). Glial tumors are subdivided into two categories, the low-grade 

gliomas, also called gliomas, and the high-grade gliomas or glioblastomas. High-grade gliomas 

are highly heterogeneous at the molecular, genetic and cytopathological levels and thus they are 

termed ‘multiform’ (Conte et al. 2021, Portela-Esteban, Casas-Tintó 2021, Furnari et al. 2007) .  

Despite GBM heterogeneity, some common mutations are found among patients, including those 

in components of the Epidermal Growth Factor Receptor (EGFR) and the Phosphatidyl-inositol-3 

kinase (PI3K) pathways (Read 2011, Portela-Esteban, Casas-Tintó 2021). In Drosophila, similar 

to humans, mutations of the EGFR and PI3K pathway alone are usually not sufficient to cause 

GBM, but rather low-grade glioma (Figure 1). Nevertheless, it was previously suggested in 

Drosophila that Ras overexpression exhibits a stronger phenotype, resembling high-grade 

glioblastoma (Read et al. 2009). GBM arises as a result of multiple mutations that lead to 

synchronous activation of multiple pathways. The EGFR pathway is essential for the normal 

differentiation, proliferation, and migration of the Neural stem cells (NSCs) and the precursor cells 

of glial cells. Mutations that cause amplification of the EGFR lead to overactivation of downstream 

pathway components including Ras, that induce proliferation and migration (Read 2011). 

The PI3K pathway controls mitotic activity, growth and migration of a variety of neuronal cells 

physiologically (Read 2011). The most common mutation affecting the PI3K pathway arise in the 

catalytic subunit of PI3K, p110α leading to the activation of the receptor and the downstream 

kinase Akt (Read 2011). PTEN antagonises PI3K resulting in controlled activation of the PI3K 

pathway. Approximately 75% of GBM cases bear loss of function PTEN mutations, that induce 

the pathway (Read 2011).   
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Other Receptor Tyrosine Kinases (RTKs) have been found overexpressed in GBMs, such as the 

PDGFR-VEGFR (PVR), which is the Drosophila homolog of the human Platelet Derived Growth 

Factor Receptor -Vascular Endothelial Growth Factor Receptor (PDGFR/VEGFR), the Breathless 

(Btl) homolog of the Fibroblast Growth Factor Receptor (FGFR), and the Insulin Receptor (InR). 

PVR overexpression has been shown to increase the migrating ability of glial cells, whereas InR 

and/or Btl overexpression was associated only with increased proliferation (Witte et al. 2009).  

Apoptosis or programmed cell death is an essential homeostatic mechanism that contributes to the 

control of tissue growth and elimination of damaged cells (Ribeiro et al. 2004). Inhibition of 

apoptosis is a hallmark of cancer cells, but that’s not the case for GBMs, where cancer cells 

undergo spontaneous apoptosis. The apoptotic rate of high-grade gliomas is higher than the low-

grade gliomas (Eisele, Weller 2013, Kuriyama et al. 2002). According to the World Health 

Organization (WHO) higher levels of pro-apoptotic agents were found in patients with GBMs and 

higher levels of anti-apoptotic agents were found in patients with low-grade gliomas (Eisele, 

Weller 2013). Some studies tried to correlate apoptotic index/proliferation ratio to patient’s 

Figure 1: Low- and high-grade gliomas in 3rd instar larva Drosophila Brain in comparison with control 

brain (Read et al. 2009) 

Ann
a K

on
sta

nti
no

u



 

7 

 

survival and use it as a tool for survival prediction. Unfortunately, the results were controversial 

since in some cases the higher apoptotic index occurred in patients with the shortest survival and 

the lower apoptotic index occurred in patients with the longest survival (Kuriyama et al. 2002, 

Ribeiro et al. 2004). The exact mechanism leading to spontaneous apoptosis of GBM cells and 

reasons for this unexpected event are still under investigation (Eisele, Weller 2013, Ribeiro et al. 

2004, Kuriyama et al. 2002).  

 

1.2 Angiogenesis and GBMs 

 

Angiogenesis is the formation of new blood vessels from preexisting ones, and aberrant 

angiogenesis is considered a hallmark of cancer (Ahir et al. 2020). During development, 

angiogenesis is an essential process that supplies the developing tissue with oxygen and nutrients. 

This process is regulated by the balance between pro-angiogenic and anti-angiogenic stimuli 

including transcription factors and growth factors (Ahir et al. 2020, Tamamouna, Pitsouli 2018).  

GBMs are characterized as highly angiogenic tumors. Increased GBM vascularization is 

considered as one of the main factors that contribute to poor patient prognosis (Ahir et al. 2020). 

Hypoxia is the condition where a part of tissue or several cells have insufficient oxygen supply. 

As the tumor grows, and the number of cancer cells increases, the preexisting vessels are unable 

to supply all the cells with oxygen leading to the formation of a hypoxic tumor core (Das, Marsden 

2013, Pecorino 2012). Any cell that is located approximately 100μm from the nearest blood vessel 

can become hypoxic, as oxygen can be diffused within the range of 100-200μm (Pecorino 2012, 

Tamamouna, Pitsouli 2018).  

Oxygen levels must be maintained within normal levels (normoxia) for the tissue to function 

properly. A key molecule that controls oxygen homeostasis is the Hypoxia Inducible Factor-1α 

(HIF-1α). HIF-1 is a heterodimer transcription factor comprised by the HIF-1α and HIF-1β 

subunits and its activity depends on the formation of the heterodimer in hypoxic environments. 

During normoxia, HIF-1α is hydroxylated by prolyl-4-hydroxylase (PHD) (Figure 2) with the 

addition of -OH to specific proline residues (Tamamouna, Pitsouli 2018). The hydroxylated HIF-

1α is recognized by the von-Hippel-Lindau (VHL) ubiquitin ligase, which binds to HIF-1α leading 

it to proteasomal degradation (Figure 2). During hypoxia, PHD is unable to hydroxylate HIF-1α. 
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The non-hydroxylated form of HIF-1α is not recognized by VHL and therefore HIF-1α is not 

degraded (Figure 2). HIF-1α is free to bind to HIF-1β forming the HIF-1 heterodimer. The 

heterodimer is able to enter the nucleus and together with the co-activator p300 can recognize and 

bind to Hypoxia Response Elements (HREs) to activate expression of pro-angiogenic genes 

including VEGF, and FGF (Figure 2) (Tamamouna, Pitsouli 2018). VEGF and FGF are the most 

common upregulated pro-angiogenic growth factors among GBM patients (Ahir et al. 2020). 

In Drosophila, oxygen is transported by tracheae, which are functionally homologous to 

mammalian blood vessels. In accordance, we refer to the formation of new tracheae from pre-

existing ones as tracheogenesis. Trachea and blood vessel formation are controlled by 

evolutionarily conserved signalling pathways. The Drosophila homolog for HIF-1α is encoded by 

similar (sima), for HIF-1β by tango (tgo), for PHD by fatiga (Fga), and for VHL by dVHL 

(Tamamouna, Pitsouli 2018). In the Drosophila developing brain the main growth factor that 

controls trachea development is Branchless (Bnl), the FGF homolog, that binds to its receptor 

Breathless (Btl), the homolog of FGFR (Pereanu et al. 2007).  

 

1.3 Drosophila melanogaster as a model organism for the study of Glioblastomas 

 

Drosophila melanogaster is one of the easiest model organisms to cultivate and the cost for its 

maintenance is low. The short life cycle (⁓10 days in 25ᵒC) (Figure 3) in combination with the 

Figure 2: The HIF-1α/ sima pathway. The light blue gradient at the bottomo of each image represents the 

levels of oxygen (Tamamouna, Pitsouli 2018) Ann
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high number of offspring in each generation allows the performance of more experiments in a 

shorter amount of time (Hales et al. 2015). In addition, Drosophila offers a variety of genetic tools, 

such as transgenic flies, ectopic gene expression, tissue specific overexpression, genetic mosaics, 

gene silencing using interference RNA (RNAi) etc (Wolpert et al. 2015). Finally, many signaling 

pathways like EGFR/RTK-Ras, PI3K, Notch, Wnt, Jak-STAT, Hedgehog and TGF-β are 

conserved between humans and flies (Read 2011). Specifically, approximately 75% of the human 

disease related genes have a functional homolog in the fruit fly (Pandey, Nichols 2011).  

Drosophila has proven to be an excellent model organism to study GBM, because many neuronal 

and glial subtypes of the mammalian brain have homolog subtypes in the fly (Read 2011). For 

example, the Drosophila neuropile glia is homologous to the astrocyte glia of the mammalian brain 

which has been found to be the primary type of glia involved in the mammalian GBM (Read 2011). 

  

 

1.4 Drosophila brain anatomy and types of glial cells  

 

The CNS of the Drosophila larval brain is composed of two spherical and symmetrical 

hemispheres and the Ventral Nerve Cord (VNC), on which the hemispheres are connected (Figure 

1) (Read 2011, Witte et al. 2009). The neurons of the Peripheral Nervous System (PNS) will 

emerge from the neurons of the VNC (Witte et al. 2009). The hemispheres are also called brain 

Figure 3: Life cycle of Drosophila, from the embryo to the adult at 25ᵒC (Wolpert et al. 2015) 
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lobes since on their surface lies the center of the brain that is necessary for the processing of visual 

information (Apitz, Salecker 2014, Li et al. 2014). This center is the optic lobe and is located at 

the surface of the brain lobes in a horse-shoe shape (Figure 1) (Apitz, Salecker 2014).  

Glial cells can be defined as the non-neuronal cells of the CNS and are derived from the precursors 

of the neuronal cells (Yildirim et al. 2019). Glial cells may not have the role of neuronal cells, but 

it has been shown that their role in the development and homeostasis of the CNS is essential 

(Yildirim et al. 2019, Kremer et al. 2017). In the developing brain, glial cells control the NSC 

proliferation rate to maintain the cell populations of the CNS (Kremer et al. 2017). In addition, 

glial cells are responsible for the removal of dying neurons, ionic homeostasis through 

neurotransmitter regulation, metabolic homeostasis of the neurons etc (Kremer et al. 2017, 

Yildirim et al. 2019). Finally, they act as the primary immune cell population of the CNS (Kremer 

et al. 2017).      

The Drosophila CNS has 3 types of glial cells, the surface glia, the cortex glia and the neuropile 

glia (Figure 4) (Hartenstein 2011). Surface glia cells are divided into two subtypes, the perineurial 

glia, which constitute the outer layer of glial cells and the subperineurial glia that are located 

beneath the perineurial layer. These two subtypes of glial cells form the blood brain barrier (Figure 

4) (Hartenstein 2011, Yildirim et al. 2019). The perineurial glia are small cells with many 

projections that allow them to form the outer layer of the blood brain barrier and do not directly 

contact the neurons. The subperineurial glia are flat, large cells, highly polyploid due to 

endoreplication that form septate junctions providing the inner part of the blood brain barrier 

(Yildirim et al. 2019).  

Cortex glia are located just beneath the subperineurial glia and are in contact with neurons (Figure 

4) (Yildirim et al. 2019). They are small round cells that build a network surrounding NSCs and 

neurons that are connected via septate and adherent junctions (Hartenstein 2011, Yildirim et al. 

2019). Cortex glia have a fundamental role for the development of neurons in the optic lobe and 

in the activation of neuroblast stem cells (Yildirim et al. 2019). In the developing brain, cortex glia 

cells are responsible for neuronal homeostasis of essential metabolic molecules (Yildirim et al. 

2019, Hartenstein 2011).  
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The deepest layer of a Drosophila larval brain is called neuropile due to the existence of the 

neuropile compartments that are hosting dendrites, axon branches and synapses. Neuropile is 

constructed by neuropile glia cells that form the septa, dividing the neuropile into compartments 

(Figure 4) (Technau 2008). During development neuropile glia and cortex glia restricts the growth 

of one another establishing the cortex-neuropile boundary (Coutinho-Budd et al. 2017). Neuropile 

glia are subdivided into two categories, the ensheathing glia and the astrocyte-like glia. 

Ensheathing glia are flat cells that cannot penetrate into the neuropile compartments (Figure 4) 

(Hartenstein 2011). Ensheathing glia act as phagocytes in the brain, therefore they are responsible 

for clearance of the apoptotic neurons, a process essential especially during metamorphosis 

(Hartenstein 2011, Doherty et al. 2009). Astrocyte-like glia are polarized cells that form brunches 

that penetrate into the neuropile compartments building a reticulum of glial cells allowing them to 

come in direct contact with terminal axons, dendrites and synapses (Figure 4) (Awasaki et al. 

2008). Astrocyte-like glia provide guidance cues to axons and sustain normal neuronal function as 

they remove the transmitter from the synaptic cleft (Spindler et al. 2009, Jackson, Haydon 2008, 

Yildirim et al. 2019). The morphological, structural, and molecular features of these cells are 

conserved between mammals and Drosophila (Yildirim et al. 2019). 

Figure 4: Image of a whole brain on the left, (Neumuller, Knoblich 2009) and a cross section of a brain lobe 

on the right (Hartenstein 2011) 
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1.5 Thesis Aims   

 

GBM is the most common malignant type of cancer of the CNS and is characterized as highly 

angiogenic. Increased GBM vascularization is considered a key factor contributing to poor patient 

prognosis and resistance to treatments. Angiogenesis plays an important role in tumor cell survival 

and malignancy, but the precise mechanisms that control the interactions between the glial cells 

and the blood vessels remain elusive (Ahir et al. 2020). Drosophila GBM models have been 

established since 2009 (Read et al. 2009) and they offered great insights in various mechanisms 

underlining the disease. Our long-term goal is to use Drosophila larvae to understand the 

mechanisms governing tracheogenesis, the functional and molecular equivalent of angiogenesis, 

in GBM. 

To assess brain tracheogenesis and its potential remodeling during tumorigenesis, we need to 

generate tumors and simultaneously label the cerebral trachea. Therefore, in the first part of my 

thesis, I took advantage of previously described mutations leading to gliomas and I examined brain 

growth, mitosis and apoptosis upon glial-specific overexpression of (a) the oncogenic form of Ras, 

RasV12, (b) the active catalytic subunit of PI3K, p110α, and (c) their combination in third instar 

larvae. To visualize the tracheae in these Gal4-UAS-dependent gliomas, I tried fluorescent 

labelling using the alternate binary systems LexA-LexAop and QF-QUAS. Because these 

approaches proved unsuccessful, in the second part of my thesis, I switched to the QF-QUAS 

system to overexpress RasV12 for glioma generation in combination with the Gal4-UAS for trachea 

visualization. This approach enabled effective glioma generation and simultaneous trachea 

visualization. Using this model, I observed increased tracheogenesis in RasV12 brain tumors. 

Further work using this model aims to genetically manipulate tracheogenesis in order to assess 

tumor growth and aggressiveness.      
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2. MATERIALS AND METHODS 

 

2.1 Binary expression systems for tissue-specific overexpression (the GAL4 – UAS, 

QF– QUAS and LexA-LexAop systems)  

 

The GAL4-UAS system is a binary system borrowed from Saccharomyces cerevisiae and it is used 

as the main tool for tissue specific expression of genes in Drosophila melanogaster (Brand, 

Perrimon 1993). The transcriptional activator GAL4 recognizes and binds to the Upstream 

Activating Sequence (UAS) allowing the expression of the downstream gene (Brand, Perrimon 

1993). Tissue-specific promoters are fused upstream of the transcriptional activator GAL4 and the 

UAS is cloned upstream of potential genes of interest (genes to be overexpressed). Such constructs 

are introduced in flies using transgenesis and can be combined to allow tissue-specific 

overexpression (Brand, Perrimon 1993). Specifically, when two such strains are crossed, the 

GAL4 that is only expressed in a specific tissue will recognize the UAS activating the expression 

of the gene of interest only in this specific tissue (Nicholson et al. 2008). Using this binary system, 

we can ectopically overexpress any gene of interest in any specific tissue (Brand, Perrimon 1993). 

The QF-QUAS system is a binary system borrowed from Neurospora crassa and its function is 

comparable with the GAL4-UAS system since QF is a transcriptional activator that recognizes 

QUAS and activates the expression of the downstream gene (Potter et al. 2010). The third binary 

system used in Drosophila is the LexA-LexAop from bacteria like Escherichia coli. The 

transcriptional activator LexA recognizes and activates the LexA operator (LexAop) leading to the 

expression of the gene downstream of the operator. Each one of these three binary systems 

functions individually from the others (del Valle Rodríguez et al. 2012).     
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2.2 Drosophila strains  

 

Strain ID  Genotype Source  

6326 w1118 BDSC 

- w; UAS-srcGFP/CyO; repo-GAL4/TM6C MSc Eirini Charalambous   

7415 w; repo-Gal4/TM3 BDSC 

5788 w; UAS-RasV12(II) BDSC 

25908 ywUAS-Dp110CAAX BDSC 

- ywUAS-Dp110CAAX; UAS-RasV12 This study  

- yw; btlGAL4UAS-srcGFP/CyO; QF2-repo/TM6C This study  

66477 yw;Pin/CyO;repo-QF2/TM6B BDSC 

64775 yw; wgSp-1/CyO,y+; QUAS-Ras85DV12 BDSC 

- w;btlGal4UAS-srcGFP/CyO (Pitsouli, Perrimon 2010) 

32207 w;I(2)**/CyO;LexAbtl BDSC 

66620 w;26XLexAop2-mcD8GFP(III) BDSC 

- w; QF6QUAS-mtd-Tomato/TM6C (Tamamouna et al. 2021) 

 

Table 1: All the genotypes used for this study and the information of the source of them 

 

2.3 Brain dissections and Immunofluorescence  

 

Dissections of late 3rd instar larval brains (⁓120 hours after fertilization) (Figure 3) are performed 

in 9-well plates in 1X PBS (Table 2). Brain dissection (within 25 minutes) is followed by fixation 

for 30 minutes at room temperature (RT) with 4% Formaldehyde (FA) (Table 2). Fixative is 

removed by 3 rinses with 1X PBS. The fixed samples are incubated with PBT (Table 2) for 2-3hrs 

at RT or overnight (12-16hrs) at 4ᵒC to ensure blocking of non-specific binding and to increase the 

penetration of the antibody in the deepest layers of the tissue. Then, the primary antibodies (Table 

3) are added and incubated overnight at 4ᵒC. The samples are washed 3 times for at least 15 minutes 

each at RT with PT (Table 2). Samples are then incubated with the appropriate secondary 
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antibodies (Table 3) at RT in the dark for 1,5-2hrs followed by 3 washes for at least 15 minutes 

each at RT in the dark with PT. Finally, the samples are mounted on glass slides with Vectashield 

(Table 2) to prevent photobleaching, then covered with a coverslip and shielded with nail polish.   

   

Reagent  Components/Source  

10X PBS 1.3M NaCl, 0.07M Na2HPO4, 0.03M NaH2PO4 

16%FA 16% Methanol-free EM-grade Formaldehyde (FA, Polysciences, Inc) 

PBT 1x PBS, 0.3% Triton X-100, 0.5% BSA 

PT 1x PBS, 0.2% Triton X-100 

Vectashield Vector Laboratories, Inc. 

 

Table 2: Reagents used for dissections and Immunofluorescence 

 

Table 3: Primary and Secondary antibodies used in this study 

Primary Antibodies Recognizing cells Secondary Antibody 

Rabbit-anti-phospho histone H3 

(pH3 1:4000) 
Mitotic cells 

Donkey- anti-rabbit Alexa 555 

(1:1000) 

Mouse – anti- Repo (8D12 1:20) Glial cells 
Donkey- anti- mouse Alexa 

555/647 (1:1000) 

Rat - anti- Elav (7E8A10 1:100) Neuronal cells 
Donkey- anti- rat Alexa 555/647 

(1:1000) 

Rabbit-anti-Drosophila caspase 

protein 1 (Dcp-1 1:100) (Cleaved) 
Apoptotic cells 

Donkey- anti- rabbit Alexa 555 

(1:1000) 
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2.4 Image and data analysis  

 

Confocal images were acquired using a Leica TCS SP2 AOBS Laser Scanning Confocal 

Microscope with the following settings: XYZ acquisitions, 20X oil objective, Average 4 and 

1024x1024 px Format, which equals 750x750 μm. Images were processed and analysed using 

ImageJ (NIH)(Schneider et al. 2012). The scale of the images was set by Analyze → Set scale → 

Distance in pixels: 1024, Known distance: 750, Pixel aspect ratio: 1, Unit of length: μm. The 

surface of each central brain was measured automatically by selecting each central brain with 

Polygon selection → Analyze → Measure. Nuclei were measured using the automated counting 

of cells (Single colour images). For this feature the image must be in grey scale (8-bit or 16-bit) 

then for the following steps were used Image → Adjust → Threshold in order to mark the nuclei 

→ Apply. This will provide a binary version of the image. In many cases the nuclei of different 

cells are merged, to avoid counting them as one before counting Process → Binary → Watershed 

can separate the nuclei by adding one pixel between them. After the image is processed and in 

binary form central brains were selected using Polygon selection → Analyze → Measure Particles 

→ Size (μm^2) 0.6-Infinity, Circularity 0.0-1.0, Show: Outlines.  

2.4.1 Statistical analysis 

 

The statistical analysis of the data was performed in Microsoft Excel by calculating the mean and 

the standard deviation from the mean. The statistical significance of the results was calculated via 

the Student’s t-test, every p-value bellow 0.05 was considered significant. The box plots were 

generated in Microsoft Excel using all the values collected by the image analysis.  
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3. RESULTS 
 

Drosophila GBM models have been developed and characterized since 2009. The authors used the 

Gal4-UAS system, and specifically, the Reverse polarity (Repo)-Gal4 driver to overexpress the 

most frequently upregulated genes in GBM patients in a tissue-specific manner (Read et al. 2009). 

They showed that glial-specific overexpression of either activated EGFR or Dp110α in glial cells 

causes low-grade gliomas in 3rd instar larvae, but the simultaneous overexpression of both causes 

high-grade gliomas, reminiscent of human GBM (Figure 1). Additionally, they suggested that 

overexpression of Ras alone, which is a downstream component of the EGFR pathway, can cause 

a more severe phenotype, since it can activate the PI3K pathway endogenously (Read et al. 2009).     

Given the above, we started our research using the known repo-Gal4-UAS model to overexpress 

Dp110a, RasV12, and their combination in glial cells to confirm previous observations and further 

study the effect of RasV12 overexpression. We focused our study on the central brain and not the 

whole brain, because the optic lobes are mostly formed by optic sensory neurons. In addition, the 

astrocyte-like glia, which are considered key in GBM (Maher et al. 2001), are located in the central 

brain of the Drosophila larva. 

 

3.1Overexpression of RasV12 alone in glial cells is sufficient to cause neoplasia 

 

To analyze the growth of gliomas in Drosophila 3rd instar larval brains, we tested mitotic activity 

in control brains and brains overexpressing RasV12, Dp110α alone and in combination using the 

pH3 antibody (Figure 5). As expected, we observed that in all genotypes the highest mitotic 

activity was observed in the optic lobe, because mostly differentiated neurons and glial cells 

populate the central brain (Figure 5 A-D’). Quantification of pH3+ cells of the central brain, where 

astrocyte-like glia resides, showed that brains overexpressing RasV12 alone or in combination with 

Dp110α exhibited significantly higher mitotic activity compared with wild type brains. 

Interestingly, we did not observe any significant differences between these two genotypes. The 

brains overexpressing the active catalytic subunit of PI3K exhibited increased number of pH3+ 

cells compared with the wild type brains, but significantly lower when compared with the brains 

overexpressing RasV12 (Figure 5E). The size of the brains overexpressing RasV12 alone and in 

combination have no significant differences when compared to each over but in both genotypes 
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Figure 5: Overexpression of RasV12 alone in glial cells is sufficient to cause neoplasia. (A-D) Maximum 

projections of whole brains stained with anti-pH3 and anti-Repo antibodies. Wild type brain (A) and brains 

overexpressing Dp110α (B), RasV12 (C), and Dp110α; RasV12 (D). (A’-D’) Grey scale of pH3+ cells that 

represent A-D respectively. (A’’-D’’) Grey scale glial nuclei that represent A-D respectively. (E) 

Quantification of pH3+ cells in the central brain. (F) Central brain surface measurements.                          

p<0.05 = *, 0.05< p ≤0.01 = **, 0.01< p ≤0.001 = ***   
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the brains were significantly enlarged compared with the wild type brains (Figure 5F). Brains 

expressing Dp110α were enlarged compared with the wild type brains but significantly smaller 

than the brains overexpressing RasV12 alone (Figure 5F). 

 

3.2 Overexpression of RasV12 alone induces apoptosis in the central brain 

 

We sought to examine apoptosis in these genotypes using the cleaved Drosophila caspase-1 (Dcp-

1) antibody (Figure 6). The higher apoptotic activity in all the genotypes was observed at the optic 

lobes of the brains (Figure 6A-D). No significant differences were observed comparing control 

brains to brains overexpressing Dp110α alone or in combination with RasV12. On the other hand, 

brains overexpressing RasV12 alone exhibited increased apoptosis not only when compared with 

the control brains but also when compared with brains overexpressing Dp110α alone or in 

combination with RasV12 (Figure 6E).  

 

3.3 Trachea of the 3rd instar larval brain can be visualized only using btl-Gal4  

 

The next step to our research was to visualize the trachea of the Drosophila larval brain. Since we 

used the Gal4-UAS to overexpress the oncogenes specifically at the glial cells, we needed a second 

binary system to specifically overexpress a fluorescent protein in the tracheal cells of the larvae. 

Therefore, we tested the QF-QUAS system, as we knew from previous experiments that QF6 is a 

specific driver for trachea cells in the adult fly gut (Tamamouna et al, 2021). Unfortunately, QF6 

was not specific to the tracheal cells of the larval brain. The QF6 driver labelled some tracheae in 

the VNC, but not the brain lobes, and it was also expressed in some Crustacean cardioactive 

peptide (CCAP) – expressing neurons (Figure 7A). After excluding QF6, we tested another binary 

system, the LexA-LexAop. A trachea-specific btl-LexA driver was available (Yuan et al. 2020) 

and thus, we tested it in the larval brains, but once again the driver was not specific for tracheal 

cells rather it was expressed in the Bursicon+ CCAP neurons (Figure 7B). Bursicon CCAP neurons 

are the CCAP neurons that express the bursicon neuropeptide and will be eliminated via 

programmed cell death during development (Lee et al. 2013). Since we tried those two systems 

and none of them was specific, we used our last option which was the Gal4-UAS system. Using 
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the trachea specific driver btl-Gal, we were able to visualize fully and with high specificity the 

trachea branching network of the larval brain (Figure 7C).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6: Overexpression of RasV12 induces apoptosis in the central brain. (A-D’) Maximum 

intensity projections of whole brains stained with anti-Dcp-1. Wild type brain (A) and brains 

overexpressing Dp110α (B), RasV12 (C), and Dp110α; RasV12 (D). (A’-D’) Grey scale Dcp-1+ cells that 

represent A-D respectively. (E) Quantification of Dcp-1+ cells in the central brain. 

p <0.05= *, 0.05< p ≤0.01 = **, 0.01< p ≤0.001 = ***   
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3.4 Overexpression of RasV12 using the QF-QUAS system is sufficient to cause 

neoplasia accompanied by neotracheogenesis     

 

After evaluating the three available binary systems in Drosophila for cell specific overexpression 

of genes for tracheal visualization, we concluded that only the btl-Gal4 was specific and 

highlighted all the brain tracheal cells, allowing visualization of the entire tracheal network. Up to 

this point, for our experiments we were using repo-Gal4 as the driver for the glial specific 

overexpression of genes. However, we could not use the Gal4-UAS system to create the glioma 

and also label the trachea. Thus, to use the btl-Gal4 for the trachea, we needed an alternative binary 

system for glial-specific oncogene overexpression. 

Therefore, we developed a strain that includes repo-QF, for overexpressing RasV12 specifically at 

glial cells, and btlGal4-UASsrcGFP for overexpressing GFP at the trachea cells. Since our results 

indicated that RasV12 is sufficient to cause neoplasia alone, we focused our experiments on RasV12.  

To validate and characterize our new glioma model, we evaluated the mitotic activity of the brains 

that overexpressed RasV12 with the QF-QUAS system using the anti-pH3 antibody (Figure 8). We 

found that brains overexpressing RasV12 have significantly increased number of pH3+ cells 

yw; btlGal4UAS-srcGFP/CyO w; QF6QUAS-mtd-Tomato/ 

TM6C 

w;l(2)**/CyO; lexAbtl 

/26XLexAop2-mcd8GFP 

A B C 

Figure 7: Tracheae of 3rd instar larvae brains can be visualized only using btl-Gal4. (A) Overexpression 

of membrane-tagged mtd-Tomato using the trachea-specific QF6 driver; the yellow arrow indicates CCAP 

neurons. (B) Overexpression of membrane-tagged mCD8-GFP using btl-LexA driver; the yellow arrow 

indicates bursicon+ CCAP neurons. (C) Overexpression of membrane-tagged src-GFP using the btl-Gal4 

driver. All images correspond to single channel maximum projections of the fluorescent protein label. 
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compared with the wild type brains (Figure 8A-B’, 8C). As expected, larvae that overexpressed 

RasV12 in their glial cells have significantly enlarged brains compared with the wild type (Figure 

8D). Finally, quantification of the integrated density of GFP revealed excessive neotracheogenesis 

in brains overexpressing RasV12 (Figure 8E).   

Figure 8: Overexpression of RasV12 using the QF-QUAS system is sufficient to cause neoplasia accompanied 

by neotracheogenesis. (A-B) Maximum intensity projections of whole brains stained with anti-pH3. Wild type brain 

(A) and brain overexpressing RasV12(B). (A’-B’) Grey scale of pH3+ cells that represent A-B respectively. (A’’-B’’) 

Grey scale btl-Gal4-UASsrcGFP showing trachea branching that represent A-B respectively. (C) Quantification of 

pH3+ cells in the central brain. (D) Measurements of the central brain surface. (E) Quantification of the cerebral 

trachea as Integrated Density of GFP. 

p<0.05 = *, 0.05< p ≤0.01 = **, 0.01< p ≤0.001 = ***   
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3.5 Overexpression of RasV12 using the QF-QUAS system induces apoptosis  

 

To further characterize our new model, we tested the effect of RasV12 overexpression in apoptosis 

of the central brain (Figure 9). The pattern of apoptosis agreed with our previous finding (Figure 

6), as the highest apoptotic activity in all genotypes was observed in the optic lobes (Figure 9A-

B’). Additionally, quantification of Dcp-1+ cells indicated increased apoptotic activity in brains 

overexpressing RasV12 compared with wild type brains (Figure 9A’-B’, C).  

Figure 9: Overexpression of RasV12 using the QF-QUAS system induces apoptosis in the central brain. 

(A-B) Maximum projection of whole brains stained with Dcp-1 antibody. Wild type brain (A) and brain 

overexpressing RasV12 (B). (A’-B’) Grey scale of anti-Dcp-1+ cells that represent A-B respectively. (C) 

Quantification of Dcp-1+ cells in the central brain. 

p <0.05= *, 0.05< p ≤0.01 = **, 0.01< p ≤0.001 = ***   
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4. DISCUSSION 

 

Drosophila GBM models have been established since 2009 by R. Read. In their study they tested 

the overexpression of several key genes upregulated in GBM patients, including activated EGFR, 

Dp110α, PTEN and the combination of those two using the repo-Gal4 driver. They were able to 

classify the tumours as low-grade and high-grade (Figure 1) according to the ability of each 

genotype to invade the surrounding tissue. From the single mutants they did not observe any 

significant invasive activity except from RasV12 that had the more invasive potential resembling 

the invasiveness of the double mutant EGFRλ;PTEN(-/-). Therefore, they suggested that 

overexpression of RasV12 may have a more severe phenotype due to its ability to activate PI3K 

endogenously. Nevertheless, they did not classify RasV12 as high-grade nor as low-grade glioma 

due to the fact that oncogenic Ras does not suffice for the development of human high-grade 

gliomas, because human GBM usually requires the coactivation of multiple pathways (Read et al. 

2009). 

Given the above, we started our research using the repo-Gal4 driver to overexpress components of 

each pathway (Dp110α, RasV12) and the combination of them. We decided to use RasV12 instead of 

EGFRλ to study its effect alone and in combination with Dp110α. Our results indicated that 

overexpression of RasV12 is sufficient to cause neoplasia and we did not observe any differences 

between the single mutant RasV12 and the double mutant Dp110α;RasV12 regarding their mitotic 

activity and their brain size (Figure 5E,F). The only difference between the double mutant and the 

single RasV12 mutant is the number of apoptotic cells. Specifically, RasV12 overexpressing brains 

exhibited significantly increased apoptotic activity compared to the other genotypes (control, 

Dp110α, Dp110α;RasV12 ) (Figure 6E). Even though one of the hallmarks of cancer is inhibition 

of apoptosis, high-grade GBM patients constitute the exception to this phenomenon, since the 

apoptotic activity in high-grade gliomas is higher than in low-grade gliomas (Eisele, Weller 2013). 

The exact mechanism underlying this phenomenon, and its contribution to the response of the 

patient to treatment or even the survival of the patient is still under investigation. 

Our next goal was to find a way to visualize the trachea and at the same time cause neoplasia by 

overexpressing RasV12 specifically in the glial cells of the larvae. After experimentally excluding 

the QF-QUAS and LexA-LexAop systems for tracheal specific overexpression we concluded that 
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only the Gal4-UAS system was specific enough to uncover the full cerebral trachea (Figure 7). In 

order to use the btl-Gal4>UAS-srcGFP to label the cerebral trachea, we needed an alternative 

system to generate the glia-specific tumour. Hence, we tested the QF-QUAS system for the 

overexpression of RasV12 using the repo-QF2 as the driver. We focused our attention on RasV12 

since we did not observe any differences between the overexpression of the oncogene alone and 

in combination with Dp110α regarding mitosis, but there was a robust difference between them 

regarding their apoptotic rate. Therefore, we used the btl-Gal4 and the repo-QF2 constructs to 

reconstruct a new Drosophila strain containing both (Table 1) and allowing glia-specific 

expression of the oncogenic Ras and GFP labelling of the trachea. Evaluation of the effect of RasV12 

in regard to cell proliferation and apoptosis in this new glioma model agreed with the Gal4-driven 

Ras model: brains overexpressing RasV12 under repo-QF2 exhibited increased mitosis 

accompanied with brain size increase (Figure 8C, D). In addition, brains overexpressing the 

oncogene had significantly higher number of apoptotic cells (Figure 9C).  

Following the characterization of our model, we proceeded with a preliminary assessment of the 

trachea quantification using the Integrated Density of GFP as a proxy and found significantly 

increased trachea in the brain lobes of larvae overexpressing RasV12 (Figure 8E). The 3D structure 

of the brains and the complexity of the cerebral tracheal network require the 3D reconstruction of 

the cerebral trachea to quantify accurately the branches in the X, Y and Z axes. We were able to 

reconstruct the 3D structure of the cerebral trachea by scanning the whole brains with confocal 

microscope and then using Fiji (Schindelin et al. 2012). Unfortunately, we have not yet managed 

to accurately quantify the cerebral tracheae due to the lack of a user-friendly tool that allows 3D 

measurements of branching.  

In the imminent future, to further characterize our model, we will test the invasiveness of the RasV12 

tumours using mosaics, i.e. mosaic analysis with a repressible cell marker (MARCM), which 

allows the study and tracing of a number of mutant cells in an otherwise wild type brain (Germani 

et al. 2018). In addition, we will try to find a way to accurately quantify the cerebral trachea (i.e. 

IMARIS and Fiji). To fully understand the function of tracheogenesis in gliomas, we will 

manipulate the tracheal cells to inhibit or overactivate their branching and we will assess the 

tumour phenotypes. For example, we will manipulate the trachea by the overexpression and 

inhibition of the FGFR homologue (Breathless (Btl) in flies). The Btl pathway is essential for the 
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trachea growth during animal development, and it is also necessary for adult neotracheogenesis 

under several stress conditions including the formation of tumours in the Drosophila gut 

(Tamamouna et al. 2021).          
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5. ABBREVIATIONS 

 

ABBREVIATION MEANING 

BDSC Bloomington Drosophila Stock Center 

Bnl Branchless 

BSA Bovine Serum Albumin 

Btl Breathless 

CCAP Crustacean Cardioactive Peptide 

CNS Central Nervous System 

Dcp-1 Drosophila caspase protein 1 

EGFR Epitermal Growth Factor Receptor 

FA Formaldehyde 

fga Fatiga 

FGFR Fibroblast Growth Factor Receptor 

GBM Glioblastoma Multiform 

HIF-1 Hypoxia Inducible Factor-1 

HRE Hypoxia Response Element 

InR Insulin Receptor 

NSC Neuronal Stem Cell 

PBS Phosphate Buffered Saline 

PBT PBS BSA Triton X 

PDGFR Platelet Derived Growth Factor Receptor 

pH3 phospho histon H3 

PHD Prolyl-4-hydroxylase 
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PI3K Phosphatidyl-Inositol-3 Kinase 

PNS Peripheral Nervous System 

PT PBS Triton X 

PVR PDGF-VEGF Receptor 

Repo Reverse polarity 

RT Room Temperature 

RTK Receptor Tyrosine Kinase 

sima Similar 

tgo Tango 

VEGFR Vascular Endothelial Growth Factor Receptor 

VHL Von-Hippel-Lindau 

VNS Ventral Nerve Cord 

MARCM Mosaic analysis with a repressible cell marker 

WHO World Health Organization  
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